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2 WELCOME TO DWMAPS 

The Drinking Water Mapping Application to Protect Source Waters (DWMAPS) is an online 

mapping tool that provides state and utility drinking water professionals, watershed protection 

groups, source water protection partnerships, and others with information to update source 

water assessments and prioritize source water protection measures in any location or 

watershed in the country. DWMAPS includes several search tools that, when used together 

with state and locally available mapping tools and data, can help users: 

 Identify potential sources of contamination;  

 find data to support source water assessments and plans to manage potential sources of 

contamination; 

 evaluate accidental spills and releases, identifying where emergency response resources 

for accidental releases must be readily available; 

 promote integration of drinking water protection activities with other environmental 

programs at the EPA, state, and local levels; and 

 identify source water protection partnerships and watershed projects. 

 

DWMAPS provides geographic data regarding the nation’s sources of drinking water and public 

water systems but obscures the precise locations of Public Water System intakes. DWMAPS has 

been designed to work in tandem with local data and information to assist with source water 

protection and emergency preparedness. 

The DWMAPS application contains map controls, search tools, and interactive data displays to 

help users navigate, visualize and sort through map data. Search tools can be accessed through 

the Welcome Screen or toolbar located in the primary map display.  

DWMAPS is hosted on EPA’s GeoPlatform and integrated with Esri ArcGIS Online, a dynamic, 

expansive, and collaborative web platform that allows users to create and share data, maps, 

analytics, and mapping applications. Users do not need access to additional software, such as 

ArcGIS, to use DWMAPS. This user guide provides step-by-step instructions for each search tool 

and navigational feature--including those provided through ArcGIS Online-- located within 

DWMAPS. Use the following link to access DWMAPS: https://geopub.epa.gov/DWWidgetApp/. 

http://epamap37.epa.gov/dwmaps/
https://geopub.epa.gov/DWWidgetApp/
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3 DWMAPS WELCOME SCREEN 

DWMAPS contains useful links and advanced search tools that are accessible from the 

Welcome Screen. Additional navigation controls and search tools are accessible from the map 

display. Figure 1 below familiarizes users with the Welcome Screen and Table 1 provides a brief 

description of each element on the Welcome Screen.  

Figure 1: DWMAPS Welcome Screen highlighting interactive tools and features. Numbers correspond with Key 
number in Table 1.  
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Table 1: Welcome Screen elements 

Key # Title Description 

1 Locate Drinking Water 
Providers 

Click Locate Drinking Water Providers to search for 
drinking water providers in a specified area. Click the 
question mark icon in the upper right corner of the box to 
access more information about drinking water providers 
on the EPA Office of Ground Water &Drinking Water 
website. 

2 Locate Potential 
Sources of 
Contamination 

Click Locate Potential Sources of Contamination to search 
for potential sources of contamination upstream of a 
specified area. Click the question mark icon in the upper 
right corner of the box to access the Integrated 
Compliance Information System and learn more about 
potential sources of contamination regulated by EPA. 

3 Locate Polluted 
Waterways 

Click Locate Polluted Waterways to search for the 
polluted waterways in a specified area. Click the question 
mark icon in the upper right corner of the box to access 
more information about polluted waterways (i.e. 303(d) 
impaired waters) on EPA’s website.  

4 Locate Projects and 
Source Water 
Collaboratives 

Click Locate Projects and Source Water Collaboratives to 
search for projects and source water collaboratives in a 
specified area. Click the question mark icon in the upper 
right corner of the box to access more about EPA’s 
watershed restoration programs and projects. 

5 Open Map Layer List Click the Open Map Layer List check box to open the Layer 
List tool upon entering the map display. The Layer List tool 
will provide a list of geospatial data layers that are 
available to view in the map display. 

6 EPA Home Click the EPA Home text link to open the EPA’s website 
home page in a separate browser window. 

7 Drinking Water Home Click the Drinking Water Home text link to open the EPA’s 
Office of Ground Water and Drinking Water webpage in a 
separate browser window.  

8 Drinking Water Data 
and Reports (SDWIS) 

Click the Drinking Water Data and Reports text link to 
open the EPA’s Safe Drinking Water Information System 
(SDWIS) Federal Reports Search webpage on the EPA’s 
website in a separate browser window.   

9 Contact Us Click the Contact Us text link to open the EPA’s Ground 
Water and Drinking Water Contact Us webpage in a 
separate browser window. 
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4 NAVIGATING AND EXPLORING DWMAPS 

DWMAPS contains a number tools that may be used to navigate and explore the map display. 

Figure 2 and Table 2 highlight tools and features located within the map display.   

Figure 2: DWMAPS map anatomy highlighting interactive tools and features located in the map display. 
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Table 2: Map Elements (corresponds with lettering of elements in Figure 2) 

Key Map Element  Function  

A Location Search Bar Zoom to a specific location by entering an address, zip 
code, or place name. 

B Zoom in Manually zoom into a target location. 

C Zoom out Manually zoom out to view a larger area. 

D Home Re-center the map display to the continental United 
States. 

E My Location Zoom to the user’s physical location. The user must 
adjust browser privacy preferences to allow DWMAPS 
to access their location. 

F Latitude and Longitude 
(Coordinates) 

Latitudinal and longitudinal coordinates coinciding 
with the cursor’s location on the map. 

G Scale Bar Scale bar adjusts as the user zooms in and out of the 
map. 

H Legend View active layers and map symbols. 

I Layer List Open the layer list to view all layers available in 
DWMAPS and to select which layers to view on the 
map. 

J Locate Nearby Discharges Search for pollutant discharges, impaired waters, and 
watershed protection projects and source water 
collaboratives within a specified radius of a selected 
point. 

K Locate Drinking Water 
Providers 

Search for drinking water providers serving a selected 
political boundary or with sources located in a 
selected watershed. 

L Locate Potential Sources of 
Contamination 

Search upstream from a selected point for potential 
sources of contamination. By default, the tool 
displays National Pollutant Discharge Elimination 
System (NPDES) permitted dischargers; to locate 
other potential point sources of contamination, open 
the layer list and activate the Other Point Sources of 
Pollution layers. 

M Locate Polluted Waterways Search upstream from a selected point for waters 
listed as impaired in accordance with Section 303(d) 
of the Clean Water Act. Also locate waters with active 
Total Maximum Daily Loads (TMDLs). 

N Locate Projects and Source 
Water Collaboratives 

Search for completed or ongoing watershed 
protection projects and source water collaboratives in 
a specified area. 

O Add Data Add data from EPA’s GeoPlatform, Esri, and other 
sources to view as layers within DWMAPS. The data is 
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not saved to DWMAPS and is only available within the 
user’s current session. 

P Print Print the current map view. 

Q About Open this window to read a brief description of 
DWMAPS. 

R Map Overview Open a small, zoomed out view of the current map 
display. 

S Attribute Table Open the attribute tables for all active layers in the 
map, and export data as a .csv file. 

 

4.1 ZOOM IN/OUT 

Use the Zoom In/Out tool (Figure 2, Map Elements B & C) and the keyboard controls to 

zoom in and out of the map display. 

To use the Zoom In/Out tool in the map display:  

1. Click the plus (+) sign to zoom in to the map display. 

2. Click the minus (-) sign to zoom out of the map display. 
 

To use the keyboard to zoom in and out of the map display: 

1. Hold the control key with one hand.  

2. Push the plus (+) key to zoom in. 

3. Push the minus (-) key to zoom out. 

To use the mouse to zoom in and out of the map display: 

1. Move the roller wheel one direction to zoom in. 

2. Move the roller ball the opposite direction to zoom out. 

4.2 PAN 

Use the mouse and keyboard controls to scroll the map display in the direction and area 

you choose.  

 

 

To use the mouse to pan across the map: 

1. Click and hold on any location in the map display. 

2. Drag the mouse, and the map will move in the corresponding direction. 

To use the keyboard to pan across the map: 

1. Push the up arrow key to move north in the map display. 
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2. Push the right arrow key to move east in the map display. 

3. Push the left arrow key to move west in the map display. 

4. Push the down arrow to move south in the map display. 
 

4.3 HOME 

The Home tool (Figure 2, Map Element D) re-centers the continental United States 

across the map display.  

1. Click the Home icon to re-center the map display. 

 

4.4 MY LOCATION 

The My Location tool (Figure 2, Map 

Element E) zooms the map display to 

your current physical location. A blue dot 

will appear on the map indicating your 

current location (Figure 3). 

1. Click the My Location icon to zoom to 

your current location. 

Note: You may be required to reconfigure 

your browser’s privacy settings to allow 

DWMAPS to access your location.   

 

 

 

4.5 LOCATION SEARCH BAR 

 

 

 

The Location Search Bar tool (Figure 2, Map Element A) allows the user to find and zoom to a 

location of interest by entering an address, city and state, zip code, coordinate, or place name. 

Figure 3: A blue dot indicates the user’s location 
on the map. 

Figure 4. The Location Search Bar tool. 
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1. Enter a location in the Location Search Bar text box (Figure 4).  

 

 The tool will display possible matches (Figure 5).  

 

2. Click the location match to select and zoom to the desired location (Figure 5);  

 

 

 

Or; 

Click the magnifying glass icon  or press enter to zoom the map display to entered 

location. If no matches are found for the input location, the map will remain unchanged.  

 

4.6  MAP OVERVIEW 

The Map Overview tool (Figure 2, Map Element R) displays a small overview map in 

the upper right corner of the map display that shows a zoomed-out view of the 

current map display. A grey rectangle within the overview map indicates the current 

extent of the primary map display (Figure 6). 

1. Click the Map Overview icon to expand the overview map. 

2. Click the expand icon        to expand the overview map. 

3. Click the minimize icon  to shrink the overview map. 

Figure 5: The Location Search Bar tool will suggest location matches for the 
inputted text. 
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4.7 COORDINATES AND SCALE BAR 

The Map Coordinates tool (Figure 2, Map Element F) and Scale Bar tool (Figure 2, Map Element 

G) can be found in the lower left hand corner of the map display. The Coordinates Tool displays 

the coordinates that coincide with the location indicated by the mouse cursor. The coordinates 

will change as the mouse is moved over the map. The Scale Bar tool indicates the scale (the 

ratio between the distance on the map and the corresponding distance on the ground) of the 

map display. The Scale Bar adjusts with the zoom of the map and is displayed in miles (Figure 

7). 

Figure 6: The Overview Map. The inlay grey box indicates the area being displayed in the main 
map view. 
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Latitude/Longitude 

of mouse cursor 

location  
Scale Bar  

Figure 7: The Coordinates and Scale Bar display. The numbers displayed at the top of the image indicate the 
longitudinal & latitudinal coordinates that coincide with the location of the mouse cursor. The scale bar (at the 

bottom) will automatically adjust when zooming in and out on the map. 

1. To get map coordinates for a specific location, click the location symbol  next to the 

longitude and latitude coordinates, then click the map. 

 

 A green location pin will mark the location and the latitude/longitude display will 

show the precise latitude/longitude of the marked location.  

 

5 VISUALIZING THE DATA 

5.1 LAYER LIST 

 

There are many useful data layers that can be viewed within DWMAPS. Use the Layer List tool 

(Figure 2, Element I) to access a range of data layers that can be viewed in the DWMAPS map 

display. Additional data layers are also available through the Add Data tool.   

5.1.1 Turn on/off layers 

1. Click the Layer List icon in the toolbar at the bottom of the DWMAPS map display,  

 

 

Or; 

Check the box next to the Open Map Layer List icon (Figure 8) on the Welcome Screen.  
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Figure 8: Open Layer List Icon. 

 The Layer List window will display (Figure 9). 

 

Figure 9: The Layer List window. 

2. Click the box to the left of the layer name to view the layer in the map display. Grey text 

indicates layers that cannot be viewed at the current map scale.  To view these layers in 

the map, zoom in or out until the layer text appears opaque.  

 

 A blue box with a check mark will show activated layers (Figure 10). 
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Note: If using a search tool (e.g. My Drinking Water), the data layers utilized within that tool will 

automatically turn on and display in the Layer List. By default, additional layers do not appear in 

the map display unless turned on by the user. If you want additional layers turned on, select the 

layers.  

5.1.2 Setting Layer Transparency 

The user can adjust the transparency of a top layer to allow them to see this layer while still 

viewing underlying layers.  

1. Within the Layer List, click the ellipsis icon located next to a layer (Figure 11). 

Figure 11: Layer List tool ellipse icon.  

 A layer options menu will display (Figure 12). 

 

Figure 12: Layer List tool layer options menu transparency button. 

2. Click the Transparency button to open the layer transparency slider. Drag the circular 

slider towards the plus or minus signs or click the plus or minus signs to adjust layer 

transparency (Figure 13). 

Figure 10: The Layer List tool with layers activated. 
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5.1.3 Access Layer Details 

Within the Layer List tool, a user can access additional information about a layer and its 

underlying data, such as a service description, metadata, and access and use constraints. The 

Layer List tool also provides access to a layer’s map service (e.g. ArcGIS Server Web Service, 

WMS OGC Web Service) endpoint, which they can use to bring the layer into a separate map or 

mapping application. Availability of information and data services may vary by the source, 

owner, and type of layer service.  

1. Within the Layer List options menu, click the Show Item Details button. Alternatively, 

click the layer Description button (Figure 14). 

 

Figure 14: The Layer List tool options menu Show Item Details button and Description Button. 

 A separate browser window will open with an Item Details page or an ArcGIS 

REST Services Directory Map Server page, depending on the layer’s map service 

origin.  

5.1.4 View Layer Attributes 

A user may access a layer’s attribute table via the Layer List tool for viewing in the Attribute 

Table tool. 

Note: Certain layer services do not provide access to layer attribute tables. This feature is set by the 

layer’s service owner and is not unique to DWMAPS.  

1. Within the layer List tool options menu, click the Open Attribute Table button (Figure 

15).  

Figure 13: The Layer List tool transparency 
slider bar. 
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Figure 15: The Layer List tool Open Attributes Table button.  

 The layer’s attribute table will open in the Attribute Table tool (Figure 16).  

 

 

Figure 16: Layer attribute table displayed via the Attribute Table tool. 

 

5.2 LEGEND 

 

The Legend tool (Figure 2, Element H) lists the data layers that are currently active and visible in 

the map and explains the symbols used on the map. In the Legend, a symbol will appear 

beneath each layer title that matches the symbol for the layer displayed on the map.  Data 

layers will appear in the legend only if they are being utilized or displayed in the map. 

1. Click the Legend tool icon in the toolbar at the bottom of the map display. 
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 The legend window will open (Figure 17). Active layers will appear in the legend. 

If no data layers are active, it will appear blank (certain layers may appear 

automatically). 

2. To close the Legend tool, click the X in the top right corner or click on the Legend tool in 

the toolbar. 
 

5.3 ADD DATA 

The Add Data tool (Figure 2, Element O) allows users to temporarily add data to the 

map by searching for layers in ArcGIS online for ArcGIS content, entering URLs, or 

uploading files from your desktop. Users can temporarily add layers to the map; 

however, data layers cannot be saved to the DWMAPS map interface. Added data 

layers will only be visible to the user that added the data and will not be visible to 

Figure 17: The Legend explains the symbols used in the map. Red lines on the map show locations of 
impaired streams and waterbodies. Green lines show locations of TMDL streams and waterbodies. 
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separate users. Users can print maps that include data added through the Add Data 

tool.  

1. Click the Add Data icon in the upper right corner of the map display. 

 

 The Add Data tool window will open (Figure 18). 

 

5.3.1 Add data from ArcGIS Online 

Esri provides access to many geospatial layers through ArcGIS Online. DWMAPS users may 

access publicly-available and licensed data services through the Search tab and ArcGIS Online 

dropdown menu option.   

1. Click the Search tab.  

 ArcGIS Online data layers that are available for viewing in the current map area 

will automatically populate in the Add Data layer list (Figure 19). Data layers that 

do not have data for the current map location and scale will not appear in the 

data layer list. 

Note: Activate the Within map area option to view only layers that are visible in the current map 

viewing area.  

Figure 18: The Add Data tool window.  
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Suggested 

Layers  

 

 

2. Locate the layer(s) of interest in the data layer list and click ADD to add the data layer to 

the map display.  

 The layer will appear in the map display, the Layer List, and the Legend.  

 

3.  Click REMOVE to remove the layer from the map, the Layer List tool, and the Legend 

tool (Figure 20). 

 

 

 

 

 

 

Figure 19: The Add Data tool window with suggested layers. 
The Within Map Area toggle.  

Figure 20: The REMOVE and DETAILS buttons. 
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Figure 22: The Add Data tool Enter A URL tab. 

4. Click DETAILS to access information about the layer and obtain the map service URL, 

which a user may use to view the same layer within DWMAPS or within a separate map 

or mapping application through their ArcGIS Online account (Figure 20).   

Optionally, to search for layers in the Add Data tool:  

1. Click the magnifying glass icon .  

 A search bar will appear (Figure 

21). 

2. Type a name or keyword to search for a 

data layer. 

 Data layers matching the search 

criteria will appear in the data 

layer list. The number of results 

will appear at the bottom of the 

window.  

3. Click ADD to add the layer to the map 

display (Figure 21). 

 

5.3.2 Add layers by URL 

1.  Click the Enter A URL tab located next to the Search tab (Figure 22).  

Figure 21: The Add Data tool search bar and ADD 
layer button. 
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2.  Click the drop down arrow and select 

the data type to be added (Figure 23). 

The following types are supported 

through the Enter a URL option: 

 An ArcGIS Server web service 

 A WMS OGC web service  

 A KML file 

 A GeoRSS file 

 A CSV file 

3.  Type or copy and paste the URL into the 

URL text box (Figure 24). 

 

  

URL text Box  

Figure 24: The Add Data text box, ADD button, and Sample URL(s) button. 

4. Click ADD to add the data to the DWMAPS display (Figure 24).  

5. Click Sample URL(s) to see the URL format for each type (Figure 24). 

5.4 PRINT 

The Print tool (Figure 2, Element P) offers the option to print the current map 

display. Only the data layers visible on the map will display in the printed file.  

1. Click the Print tool icon in the upper right corner of the map display.  

 

 The Print tool display will appear (Figure 25). 

 

Figure 23: The Add Data tool drop down menu 
arrow. 
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2. Select the applicable print layout option from the Layout dropdown menu (Figure 26). 

 

 

 

 

 

 

 

 

 

 

3. Select the applicable file type from the Format dropdown menu (Figure 27). 

Figure 25: The Print tool display. 

Figure 26: The Print tool option Layout dropdown 
menu. 
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Figure 27: The Print tool Format dropdown menu. 

 

4. Click Advanced from the Print tool display (Figure 25) to customize the map size and 

quality and to choose between printing the map scale or extent (Figure 28). 

 

Note: Map scale/extent section defines the area to printed area. Try both options and select which 

works best for your uses. 

 

 

 

 

 

 

 

 

 

5. Click Print once desired settings are selected. 

Figure 28: Print tool Advanced 
Customization options. 
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5.5 ATTRIBUTE TABLE 

The Attribute Table tool (Figure 2, Map Element S) lists information for features in 

the map layer in tabular format. Users may use this tool to filter and select 

(highlight) attributes to view in the map and in the attribute display.  Attributes 

tables are available for Layer List layers and user-added external layer services that 

are query capable. A query capable layer will have the Open Attribute Table option 

available in the layer’s description tab. 

5.5.1 Open Layer Attribute Table  

1. Click the Attribute Table tool icon in the bottom right corner of the DWMAPS map 

display (Figure 29). 

 The attribute table will display below the map panel. Attribute table field names 

appear above the feature values (Figure 29).  

Figure 29: Map display with Attributes Table tool icon and open display. Field Names and Feature Values shown. 

Attributes Table 

Display  

Data Field Names  

Data Feature Values 

Attributes Table 

Icon 
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Or;  

Click the Open Attribute Table text link within the Layer List tool to view attribute data for 

a specific data layer (Figure 30). View detailed instructions on accessing attribute 

information through the Layer List tool in the Layer List in Section 4.1.4. of this document.  

 

Figure 30: Open Attribute Table link in Layer List tool window. 

 

 

 

Options 

dropdown menu 

Layer Tab  

 

2. Within the Attribute Table tool, select a layer tab from the layer panel to view that 

layer’s attribute table (Figure 31).  

Or; 

Click the options dropdown menu icon and select a layer from the dropdown menu 

(Figure 31 & Figure 32). 

Figure 31: The Attribute Table tool layer viewing panel with layers tab and Options dropdown menu. 
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Available Layers  

Figure 32: The Attribute Table tool layer dropdown menu. 

 

 The selected data layer will be underlined in blue in the layer panel (Figure 33). 

 

 

 

3. Click the Attribute Table tool icon          on the map display to close. 

5.5.2 Filter & Select Attributes 

Use this tool to filter and select which data within a layer to view on the map and in tabular 

format. Use this tool to download a table with selected attributes.  

To show only data being displayed in the current map view in the attributes table:  

 

1. Click Filter by Map Extent to view data only visible in the current map view (Figure 34). 

 

Figure 34: Attribute Table Filter by Map Extent button. 

Figure 33: Selected layer panel. 
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 The Attribute Table tool will show only data in the table that coincides with the 

data currently visible in the map display (Figure 35).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  r

To filter table records using a filter expression: 

1. Click the Options dropdown menu button and the select Filter button to access the 

Filter expression window (Figure 36). 

 

 

 

 

 

Figure 35: The ecords that show in the attribute table will match those displayed in the map. In this image, the 
two records displayed in the attribute table coincide with the two orange points in the map.  

Figure 36: The Attribute Table tool 
Options dropdown menu and Filter 
button 
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2. Set the filter expression. The left dropdown menu sets the attribute field to be 

searched; the middle box sets the function logic; and the right box sets the value, field 

or unique value by which to filter. Click OK at the bottom of the page (Figure 37). 

 

 

 

 

 

 

To filter records by data field (column): 

1. Click the Options dropdown menu button (Figure 38). 

2. Click the Show/Hide columns button (Figure 38). 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 37: The Attribute Table tool Filter tool expression window. 

Figure 38: The Attributes Table tool Options 
dropdown menu and Show/Hide Columns button.  



P a g e  | 30 

 

Office of Water (4606-M) EPA 816-B-17-004 November 2017 

 

3. Select the data field(s) to display by checking or unchecking the boxes (Figure 39). 

 

 

 

 

 

 

 

 

 

 The attribute table will only show the selected data fields (columns) (Figure 40). 

 

 

 

 

Figure 40: Attribute Table tool display with selected attributes.  

Figure 39: Attribute Table 
tool data fields selection 
menu.  
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To filter by record (row): 

1. Click the left side of a record row. 

 The record row will highlight (Figure 41). 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Click the Options dropdown menu (Figure 42).  

 

3. Click the Show Selected Records button (Figure 42). 

 

Figure 41: Highlighted record row in Attributes Table tool.  
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. 

 

 The attribute table will only display the selected records (Figure 43).  

 

 

 

 

 

 

 

 

 

 Figure 43: The Attributes Table tool display with only selected records.  

Figure 42: The Attributes Table tool options 
dropdown menu button and Show Selected 
Records button. 
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5.5.3 Highlight an Attribute on the Map Display 

Use this feature to highlight features on the main map 

display.  

1. Click the left side of a record row. 

 The row will highlight (Figure 43) 

2. Click Zoom to. 

 The map display will zoom to the selected 

record location, which is highlighted in blue 

(Figure 44).  

5.5.4 Export Attribute Data 

Use this feature to export attribute information in a Comma Separate Values (CSV) file.  

1. Click Select the Options drop down menu button. 

2. Click Export All to CSV to export all of the desired data layer’s attributes in a CSV file 

format (Figure 45).  

 

 

 

 

 

 

 

 

 

Or; to export select attributes to a CSV file; 

 

3. Select the desired record row(s) in the attribute display (Figure 46); 

Figure 44: The blue highlighted point 
indicates the selected record. 

Figure 45: The Attributes Table tool options 
dropdown menu and Export All to CSV 
button. 
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4. Click the Option menu; click Export Selected to CSV. 

5. Click OK at the bottom of the page when the “Export data to CSV file?” window opens. 

6 SEARCH TOOLS 

The DWMAPS application contains several search tools that enable users to filter, select, and 

view information to help them locate drinking water providers, locate potential sources of 

contamination, located polluted waterways, and locate projects and source water 

collaboratives. Users can access search tools either on the Welcome Screen or on the Search 

Toolbar at the bottom of the Map Display.  

6.1 LOCATE DRINKING WATER PROVIDERS 

Use this search tool to view information about drinking water providers and to locate sources of 

drinking water. 

Figure 46: The Attributes Table tool display with records row selected. 
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The Locate Drinking Water Providers tool (Figure 2, Map Element K) 

provides information on Public Water System (PWS) service areas and 

sources of drinking water. Service area information is displayed at the 

county level, while drinking water source information is displayed by 

Hydrologic Unit Code (HUC 12) watershed. The tool provides links to 

information, including service population, source type, and violations, 

reported by the state, tribe or territory, within EPA’s Safe Drinking Water 

Information System (SDWIS). DWMAPS does not display the actual 

locations of Public Water System intakes facilities. 

1. Select the Drinking Water Providers tool from the Welcome Screen;  

Or;  

Click the Drinking Water Providers tool icon from the toolbar at the bottom of the 

DWMAPS map display (Figure 47). 

 

 

 

 

 

 

 The Drinking Water Providers search w



indow will open in the map display. 

 The Drinking Water Providers tool search window will display (Figure 48) 

2. Type in an address, zip code, latitude/longitude coordinates, or place name in the 

search bar and press enter on your keyboard, click a suggestion from the pop-up box, or 

click the magnifying glass icon  to search the location. 

Figure 47: The Drinking Water Providers tool icon in tool bar in the DWMAPS map display. 

Figure 48: The Drinking Water Providers tool search 
window. 
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Or; 

Click a point on that map to search that area.  

 The map will zoom to the location and generate results that match the area 

selected (Figure 49).  

Figure 49: The Drinking Water Providers tool will initially highlight on the map the geographic area served (e.g. 
county) that encompasses the point clicked or place entered. The results window will show all systems that serve 
the designated area. 

 

 The Drinking Water Providers tool results window will display (Figure 49). The 

results window will automatically display the Area Served results, as indicated by 

the Area Served tab. 
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6.1.1 Systems by Area Served  

The Area Served tab lists all public drinking water 

providers serving the county encompassing the 

selected location or map point. Upon searching a 

location, the Area Served results will automatically 

display in the Drinking Water Providers results 

window (Figure 50). 

1. Click the More Details button to view more 

information about that drinking water 

provider. 

6.1.2 Systems by Source of Drinking Water  

The Watershed tab lists all drinking water providers 

that have a drinking water source within the HUC12 

watershed encompassing the selected location or 

map point (Figure 51).  

1. Within the Drinking Water Providers results 

screen, click the Watershed tab to view 

drinking water providers with a source of 

water within that HUC12 watershed.  

2. Click More Details to view more information 

about the drinking water provider (e.g. 

facilities, violations).  

3. Click the Export Data Table at the bottom of 

the results window to export the drinking water 

providers list into an Excel file (Figure 52).       

Figure 50: The Drinking Water Providers tool 
results window, Area Served tab results.  

Figure 51: The Drinking Water Providers 
tool results window, Watershed tab 
results. 
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Note: Click the Area Served or Watershed tabs to move between the respective results. Enter a 

search term into the search bar or click and re-click the Drinking Water Providers tab to start a new 

search. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 52: Drinking Water Providers tool Export 
Data Table text. 
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6.2 POTENTIAL SOURCES OF CONTAMINATION 

Use this search tool to locate potential sources of contamination upstream.  

The Locate Potential Sources of Contamination search tool (Figure 2, 

Map Element L) locates and highlights National Pollutant Discharge 

Elimination System (NPDES) permitted facilities located upstream from a 

user-designated point, within a range of 1-10 miles. Potential 

contaminant sources are indicated by a yellow icon in map. Further 

details on each potential contaminant source identified, including 

enforcement and compliance history, are made available in a results 

window. This search tool intends to help users identify where they may 

be able to engage in the CWA to protect sources of drinking water. Refer 

to the Clean Water Act-Safe Drinking Water Act Coordination Toolkit for 

more information.  

1. Select the Potential Sources of Contamination tool on the Welcome Screen, 

Or; 

 Click the Potential Sources of Contamination tool at the bottom of the DWMAPS map 

display (Figure 53). 

 

Figure 53: The Potential Sources of Contamination tool icon in toolbar in the DWMAPS map display. 

 The Potential Sources of Contamination tool results window will display (Figure 

54). 

http://sourcewatercollaborative.org/connect-with-others/use-the-clean-water-act-to-protect-drinking-water/
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2. Type in an address, zip code, latitude/longitude coordinates, or place name in the 

search bar. Hit enter or click on the magnifying glass icon to zoom to a place of 

interest (unlike the Drinking Water Providers tool, the Potential Sources of 

Contamination tool will not automatically search the location. You must click a location 

on the map to conduct a search) (Figure 54). 

3. Adjust the slider bar to the preferred search distance up stream (1-10 miles) (Figure 55). 

4. Click on the map to perform the search.  

Figure 55: The Potential Sources of 
Contamination tool search distance slider bar. 

Figure 54: The Potential Sources of 
Contamination tool search window. 
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 Locations of all NPDES-permitted facilities discharging directly to water within 

the specified search distance will be marked by yellow box on the map. The 

Potential Sources of Contamination search results window will appear with a list 

of these facilities (Figure 56).  

Figure 56: Potential sources of contamination located within the search distance upstream will be marked by a 
yellow square on the map. View more information about these facilities in the results window or by clicking on the 
yellow square on the map. 
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5. Click Details in the search results or click the 

yellow square icon on the map (Figure 56) 

to view more information (e.g. compliance, 

pollutants, monitoring) about the listed 

facility (Figure 57). 

6. Click the National Pollutant Discharge 

Elimination System link at the top of the 

results window to view more information 

about the Clean Water Act NPDES program 

(Figure 57).   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 57: The Potential Sources of Contamination 
tool search results window with details link and 
National Pollution Discharge Elimination System 
link. 
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6.3 NEARBY DISCHARGES 

Use this search tool to find potential sources of contamination, source water protection projects, 

and waters identified as impaired under Clean Water Act 303(d) provision and Total Maximum 

Daily Load (TMDL) waters within a search radius. 

The Nearby Discharges tool (Figure 2, Map Element J) locates NPDES-permitted discharge 

points, Clean Water Act Section 319 nonpoint source pollution projects, impaired waters (under 

CWA Section 303(d)), and assessed waters (under Section305(b)). Unlike the Potential Sources 

of Contamination tool, which provides results upstream from a given point, the Nearby 

Discharges provides results that fall within a specified radius (1 to 30 miles) of an address, 

place, or specified location by clicking on the map. The tool is not located on the Welcome 

Screen but can be found at the bottom of the DWMAPS map display.  

1. Select the Nearby Discharges tool from the tool bar at the bottom of the map display 

(Figure 58). 

 

Figure 58: The Nearby Discharges tool icon in tool bar in the DWMAPS map display. 

 

 The Nearby Dischargers search window will appear (Figure 59).   

 

 

 

 

 

 

 
Figure 59: The Nearby Discharges search window.  
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2. In the tool search window, adjust the slide bar to the desired search radius before 

specifying your search location (Figure 60). 

Figure 60:  The Nearby Discharges tool search distance slider bar. 

 

3. Enter an address, zip code, latitude/longitude coordinates, or place name in the search 

tool bar (Figure 61). Press enter or click on the magnifying glass icon  to search,   

Or; 

Click on the map to search a 

different location. 

 A green circle on the 

map indicates the 

selected search radius 

(Figure 62).  

 

Figure 62: A green circle will indicate the search radius from the point selected.  

Figure 61: The Nearby Dischargers tool search bar.  
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 A window will also appear that 

displays search results for NPDES-

Permitted Facilities that Discharge 

to Water, Impaired Streams and 

Waterbodies (listed under CWA 

Section 303(d)), Assessed Waters 

(under CWA Section 305(b)), and 

Nonpoint source projects (funded 

under CWA Section 319 non-point 

source pollution grants) that are 

located within the search radius. 

The number in brackets for each 

search result category indicates the number of items meeting discharge category 

(Figure 63). 

 

4. Adjust the search radius using the slide bar in the results window. The green search 

radius on the map and results list will update as you adjust the slide bar. 

 

5. Click on a category link to view detailed results (Figure 64).  

 

Figure 64: Nearby Dischargers tool results window category links.  

 A facilities list will appear (Figure 65). 

Figure 63: Nearby Dischargers tool search results 
window. 
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Figure 66: Nearby Discharges tool individual facility details 
information.  

 

Figure 65: Nearby Dischargers tool results window facilities 
list  

 

 

 

 

 

 

 

 

 

 

6. Click on an individual facility link for more details. 

 Additional information will appear in the window with a link to further 

information (Figure 66). 

.  
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Figure 67: The Locate Polluted Waterways tool icon in tool bar in the DWMAPS map 
display. 

 

6.4 POLLUTED WATERWAYS 

Use this search tool to locate polluted waterways.  

The Clean Water Act (CWA) requires states to identify waterbodies-- 

rivers, streams, and lakes-- that are “impaired,” or not meeting the water 

quality standards to support activities such as recreation, fishing, and 

public water supply. The Locate Polluted Waterways search tool (Figure 

2, Map Element M) allows users to search for CWA waterways that are on 

impaired waters list and/or have an active Total Maximum Daily Load 

(TMDL). This search tool intends to help users identify where they may be 

able to engage in the CWA to protect sources of drinking water. Refer to 

the Clean Water Act-Safe Drinking Water Act Coordination Toolkit for 

more information. 

1. Click the Locate Polluted Waterways box on the Welcome Screen  

Or; 

Select the icon from the search bar at the bottom of the DWMAPS map display (Figure 

67). 

 

 

 The Locate Polluted Waterways window will appear (Figure 68). 

 

http://sourcewatercollaborative.org/connect-with-others/use-the-clean-water-act-to-protect-drinking-water/
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2. Enter an address, zip code, 

latitude/longitude coordinates or 

place name into the search bar to 

zoom to an area of interest. 

3. Adjust the slide bar to set upstream 

search distance. 

4. Click a location on the map to 

perform a search. Click on a waterbody 

for best results. 

 

 The polluted waterways (TMDL and impaired waterbodies) located within the 

search distance will highlight in yellow on the map.  A window will appear that 

displays a list of search results (Figure 69). 

Figure 69: Polluted waterbodies that are within the search distance upstream will highlight in yellow on the map. 

The results window will display more information about these waterbodies.   

Figure 68: The Locate Polluted Waterways tool search 
window.  
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5. Click a waterbody line or area on the map 

to view more information about that 

waterbody, including a Waterbody 

Quality Assessment Report. 

6. To view more information about the 

causes of impairments, click on the 

Impairments tab in the results window 

(Figure 70). 

7. To view more information about the 

selected TMDLs, such as the type of 

impairment, click on the TMDLs tab in the 

results window (Figure 70).  

8.  For more information on an impairment 

or TMDL, click the Details link. A new 

window will open with a Waterbody 

Quality Assessment Report for an 

impairment or a TMDL Report for a TMDL 

(Figure 70).  

 

 

 

 

 

 

 

 

Figure 70: The Impairments tab, TMDL tab and 
Details link in the Polluted Waterways tool results 
window.  
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6.5 PROJECTS AND SOURCE WATER COLLABORATIVES 

Use this search tool to locate watershed projects and source water collaboratives working in a 

specified area.  

The Locate Projects and Source Water Collaboratives tool (Figure 2, 

Map Element N) locates and displays the location of ongoing and 

completed Nonpoint Source Management Program grants funded by 

Section 319 of the Clean Water Act and the location of source water 

collaboratives. The tool identifies projects upstream of a user-defined 

location. This tool is intended to inform users about source water 

protection activities and programs in their area so that they may get 

involved. For more information on source water collaboratives and tools 

for source water protection visit the national Source Water Collaborative 

website. 

1. Click the Locate Projects and Source Water Collaboratives box on the Welcome Screen,

Or; 

Click the icon in the toolbar at the bottom of the DWMAPS map display (Figure 71). 

 The Locate Projects and Source Water Collaboratives search window will appear

and the location of restoration projects will display as purple lines and areas in

the map (Figure 72).

Figure 71: The Locate Projects and Source Water Collaboratives tool icon in tool bar in the 
DWMAPS map display. 

http://sourcewatercollaborative.org/
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2. Type in an address, zip code, 

latitude/longitude coordinates, or 

place name into the search 

toolbar to zoom to an area of 

interest. 

3. Adjust the slide bar for desired 

search distance upstream. 

4. Click on the map to perform the 

search. 

 Completed and ongoing 

Section 319-funded projects will highlight in yellow on the map (Figure 73). 

  A window will appear that displays a list of search results, including the source 

water collaboratives located within the search area (found at the bottom of the 

search results window) (Figure 73). 

5. Click the Details link (Figure 74) for additional information about that Section 319-

funded project. A new browser window will open with Grants Reporting and Tracking 

Figure 72: The Locate Projects and Source Water 
Collaboratives tool search window. 

Figure 73: The waterbody area(s) with completed or active restoration projects will highlight yellow on the map. The results 

window will display more information about these projects.  
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System information (GRTS), including the project title, project manager, contact 

information, project budget, and a project summary.  

Note: If a source water collaborative is present in the user defined area, it will appear at the 

bottom of the search window with a link to more information on the collaborative (Figure 75). If a 

source water collaborative is not present in the user defined area, the search window will not 

display information about source water collaboratives.  

 

Figure 74: The Details link in the Projects and Source 
Water Collaboratives tool search results window.   

Figure 75:  Source water collaboratives 
located in the area selected will appear in the 
Projects and Source Water Collaboratives tool 
results window.  
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7 HELP AND CONTACT US 

For additional information, comments on usability, or help navigating DWMAPS, please visit the 
DWMAPS support site: https://dwmaps.zendesk.com/hc/en-us  

https://dwmaps.zendesk.com/hc/en-us
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